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System Requirements 

As LinkColor is designed to control the Blackmagic Design HDLinkPro and HDLinkPro 
3D hardware, it is presumed that the user has at least one of these. LinkColor will 
control up to six HDLinkPros, either independently or in selectable groups, as 
desired. The software will run without any HDLinkPros connected. 

Additionally, LinkColor requires an Intel based Mac with one or more USB ports for 
connection to HDLinkPro. It will run under systems 10.5 up through 10.10 (to 
date). Note that while LinkColor functions fine under El Capitan (System 10.11+), 
the Blackmagic HDLinkPro drivers are not currently supported in that system. The 
main operating window will fit nicely on a screen as small as 1024 x 768 resolution. 

Installation 

Your download will be delivered as a zipped Mac folder that contains the 
application and this documentation. Double-clicking on this .zip file will 
decompress it into a folder that may then be dragged to a location of the user’s 
choice, usually the Applications folder. 

Upon launch, if this is the first launch of a licensed application, the user will be 
asked to enter a key that is linked to the serial number of the licensed machine. If 
the user has not licensed LinkColor, it may be run in the 15 minute timed demo 
mode. 

When entering a purchased key, it is necessary to be logged in using an Admin 
account. The key is stored as noted at the end of this documentation, allowing 
LinkColor use by any logged-in user. 

Additional Installation and Operational Notes 

It is necessary to install the Blackmagic Design HDLinkPro software prior to running 
licensed versions of LinkColor. This installs the drivers that provide access to the 
hardware. Also, be careful to install the Blackmagic software/drivers without the 
HDLinkPro attached to the computer, before restarting and connecting the 
HDLinkPro. Further details for installation of the Blackmagic Drivers should be 
included with your HDLinkPro. 

There is a slight issue with the first use of a new HDLinkPro. When used with a 
brand new HDLinkPro, or an HDLinkPro that has not been set up to Send Video To 
All Outputs, adjustments will not be visible on the HD-SDI output (adjustments will 
be visible only on the HDMI or other output). The workaround for now is to run the 
Blackmagic HDLinkPro utility and set the checkbox controlling that setting. The 
box should now remain in that state indefinitely. We hope to be able to set this 
directly in updated release versions of LinkColor. We have also heard reports of 
problems with newer HDLinkPros not outputting over SDI, and there are 
workarounds reported for dealing with those. They seem to pertain to the DVI 
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HDLinkPros, and can be tricked by booting them with a DVI device attached. No 
further info from Blackmagic at this time, and no first hand experience with this 
issue. 

Operation 

Upon launch of a licensed application, you will see the LinkColor window, a User 
Matrix window, a Global Presets window, and a Multi HDLinkPro Assignment 
Window, as discussed below. 

If any of these windows is not open or visible, check under the Windows menu 
item to either open individual windows, or to bring all windows to the front 
(Command-A). 

There is also a Preferences dialog that can be selected from the LinkColor menu. 
Once opened, it will remain open, or may be closed, as desired. Any change of 
settings in the Preferences dialog is immediately effective. 

Under the Tools menu there is an item labeled Invert Display (command-8). This 
selection inverts the colors used for the RGB and other color indications so that 
they will appear consistent when used in conjunction with the Mac OS black-on-
white display mode (control-option-command-8). The setting of this toggle will 
persist across relaunches of the LinkColor application. This feature has been 
implemented to satisfy the needs of users wishing to run the application in the 
dark environments commonly used in production situations. 
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Main Application Window 

 

Legal and Extended Conversions 

There are two conversion checkboxes available for the processing of Legal and 
Extended ranges. The first checkbox will convert Legal range input to extended 
range output, and the second checkbox will convert Extended range output to 
Legal range output.   

Tone Map 

The Tone Map section has a Load… button that allows you to load one of a number 
of compatible 1D Tone Map files, and apply it prior to your slider adjustments. The 
main Tone Map checkbox will enable/disable application of the Tone Map. This 
checkbox will not function unless a proper Tone Map has been Load… ed. Any 
attempt to load an incompatible Tone Map will be met with a notice of the 
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incompatibility. Included in the documentation is a sample 1D tone map file which 
reveals the necessary formatting. 

There is also a Clear button in this section. Pressing this button will clear the 
current contents of the Tone Map window, and disable any enabled Tone Map. 

Sliders 

There are three groups of sliders and steppers that control Ped, Gamma and Gain. 
Alongside each of these groups is an Up/Down arrow stepper that moves all three 
(RGB) adjustments together, in other words, a master stepper. There is an 
additional slider which functions to adjust Saturation. 

There are also steppers that control Warm/Cool color temperature, and 
GreenShift. The Warm/Cool and GreenShift steppers make the noted adjustments 
while holding picture luminance constant. 

All of the steppers can be clicked once or any number of times, or held down for 
faster adjustment. As they are held down, they accelerate for larger changes. It 
may take a little getting used to this operation, but it seems to provide both fine 
and gross control for the settings. These accelerated values may yet be further 
fine-tuned. 

The above controls can be represented in the 10 parameters specified by the ASC 
CDL proposed standard. They are pretty much implemented as per the ASC CDL 
spec. The text boxes reflect the current values being applied, and these are the 
values that are exported as per the CDL spec. Appropriate values may also be 
directly entered in those text boxes, and will set the sliders accordingly. 

All of the small buttons with the “R” in the center are reset to default buttons for 
the associated control. 

DeLog LUT 

The DeLog LUT section has a Load… button which allows you to load one of a 
number of compatible 3D LUT files, and apply it prior to, or following, your slider 
adjustments (as chosen with the associated check box). The main DeLog LUT 
checkbox will enable/disable application of the DeLog LUT. This checkbox will not 
function unless a proper LUT has been Load… ed. In the Preferences dialog there is 
a list of compatible LUT files that may be loaded. These are also listed in the 
appendices to this manual. Any attempt to load an incompatible LUT will be met 
with a notice of the incompatibility. 

There is also a Clear button in this section. Pressing this button will clear the 
current contents of the LUT window, and disable any enabled LUT. 
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To the right of the DeLog LUT checkbox is a box indicating the associated settings 
pertaining to the order of the DeLog LUT application (as set in the checkbox), and 
the status of the DeLog LUT inclusion/exclusion in any 3D file exports. 

Display LUT 

Similarly, the Display LUT section has a Load… button that allows you to load one 
of a number of compatible 3D LUT files, and apply it following your slider 
adjustments and DeLog LUT (if enabled). In the Preferences dialog there is a list of 
compatible LUT files that may be loaded. The checkbox will enable/disable 
application of the Display LUT. The checkbox will not function unless a proper LUT 
has been loaded. Any attempt to load an incompatible LUT will be met with a 
notice of the incompatibility. 

There is also a Clear button in this section. Pressing this button will clear the 
current contents of the LUT window, and disable any enabled LUT. 

To the right of the Display LUT checkbox is a box indicating the order of 
application of the Display LUT, and the status of the Display LUT 
inclusion/exclusion in any 3D file exports. 

The BYPASS button toggles the HDLinkPro between Unity (no adjustment) and your 
current settings. The Bypass Local Sliders button toggles the sliders in this 
window on and off, leaving the DeLog, Display, and User Matrix settings applied as 
checked. 

Reset Local Sliders resets all sliders in this window (not including those in the 
User Matrix window) to their default (Unity) settings. 

Copy/Paste to/from current page buttons allows the User to copy the current 
page settings and paste them to another page, as selected by the buttons 
numbered 1-6. 

Save As Default HDLinkPro Power Up writes the current working LUT into the 
NVRAM of the HDLinkPro as the power-up default. 

Enable User Matrix checkbox controls implementation of any adjustments made 
in the User Matrix window of the application. 

The Display Status window at the top center will indicate whether or not the 
current settings have been stored and, if so, which setting is currently in effect. 

In the top right corner of the window is an indication of the cube size that will be 
exported. Though always resized to 17^3 in the HDLinkPro hardware, internal 
calculations and exports are done at a larger cube size. The export size is 
selectable in the Preferences dialog (see below), and when changed, takes effect 
at the next and subsequent exports. 
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There are also indications of the current status of the CDL Server, described below 
in the Preferences section. Also, a counter, and reset button for the number of 
requests received. This is merely to serve as an indication that requests are being 
made and serviced. Also, a system beep is implemented anytime a request is 
serviced. If the sound on your Mac is muted, this system beep will be reflected as 
a screen flash. Again, this is merely an indication that a CDL Server request has 
been received and serviced. 

At the bottom of the Main Window screen are 6 buttons numbered 1 through 6. 
Most of the descriptions/adjustments noted in this section apply only to the 
numbered page currently active. The active page is indicated by the lowlighted 
button and associated background color. These pages pertain to the Multi 
HDLinkPro Assignment operation discussed in the following section of the manual. 
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Multi HDLinkPro Assignment Window 

The Multi HDLinkPro Assignment window is composed of two major sections. 
Section one contains the attributes associated with each HDLinkPro. Section two is 
a grid that allows the assignment of an HDLinkPro to a specific controller. 

 

Up to six HDLinkPros can be controlled at any time, either by a single control or by 
individual controls. An HDLinkPro can only be controlled by one controller at a 
time. 

Section 1: 

Section one has five components; an on-line indicator, a Label, an optional IP 
Address, a Set/Ping pair of buttons, and an HDLinkPro identifier button. 

The on-line indicator is shown above as a small simulated LED adjacent to the 
Label field. When an HDLinkPro is plugged in, this indicator will change from red 
to green. They will sequentially be assigned to the next available HDLinkPro (A – 
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F). If several HDLinkPros are plugged in at the same time (e.g. - at startup), it may 
be difficult to tell which one has been associated with a specific attribute group. 
When this occurs, simply press and hold the HDLinkPro (A – F) identifier button, 
and a signal will be sent out to the device that will cause the associated display to 
appear black for as long as the button is held down. Once you know which camera 
has been assigned to the device, it is good practice to place some informative 
information into the label field as a reminder. 

NOTE: If you force an ordering of assignments of the HDLinkPros (i.e. - by plugging 
them in one at a time), this ordering will not necessarily be preserved between 
subsequent power down and power up cycles. If you start the process with all the 
HDLinkPros plugged in at power up, they will be discovered in the same order each 
time, and re-identifying them and reassigning them to controls can thus be 
avoided. 

The other two components, consisting of the IP Address field and the Set/Ping 
buttons, are used when a Codex (or similarly compatible) recording device is being 
used to capture CDL information at record time. (Please refer to the Server setup 
information elsewhere in this document.) Once you have entered an IP Address 
into the IP Address field, it is a good idea to see if the device at that address is 
visible to the LinkColor system. This can be accomplished by pressing the Ping 
button. Once you have determined that the device is present, you can associate 
the HDLinkPro with that device by pressing the Set button. The Set button will 
remain highlighted for as long as you wish to keep that IP Address associated with 
the HDLinkPro. You will not be able to change the address again, until you 
disassociate the HDLinkPro with that address by pressing the Set button again. If 
that address is already associated with another HDLinkPro you will receive an error 
message to that effect. Only a single HDLinkPro can be associated with an IP 
Address. 

NOTE: You may press the Ping button at any time regardless of the state of the Set 
button and even when the Server is turned off. 

Section 2: 

This section consists of the dynamic assignment grid that creates an association 
between a specific HDLinkPro and a specific controller. In the example above, 
there are three HDLinkPros connected. HDLinkPro C will be controlled from page 
1, B from page 2, and A from page 3, respectively. You can change these 
associations at any time. Only HDLinkPros that are on-line (as indicated by a green 
LED), will be affected. 

Alongside the assignment grid, and associated with each of the pages (1-6), is an 
editable text field allowing (almost encouraging) the user to enter a short 
identifier for each page. This identifier will be reflected in the Main Window below 
the associated page selector button. More significantly, this identifier will be 
appended to the exported file names, eliminating the need to segregate exports 
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by foldering, or some other heretofore clumsy method. In other words, if multiple 
page exports were exported, as above, they would end up in a single folder named 
(by the user at export time), e.g. Sc101, as: 

Sc101_A_hdl.cube 
Sc101_B_hdl.cube, 

and so forth. 

This new method eliminates the nested foldering used in prior versions, and more 
conveniently maintains the associated exports in a clearer structure. This is again 
described in more detail in the Exporting section later in this document.  
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Preferences Dialog 

General Tab 

 

The General Tab contains a check box that will cause the Ped Sliders to Operate in 
Lift Mode. This attempts to preserve overall gain when adjusting black level, as 
opposed to offsetting the curve, gain and all. 

Another checkbox allows you the opportunity to clip the HDLinkPro output to the 
legal 10 bit code range (4-1019) in the event you are using equipment which doesn’t 
behave well when confronted with those codes. (This use of the term legal should 
not be confused with the terms legal/full/extended as generally applied to 
corrections in 10 bit lookup tables.) Additionally, you can choose whether or not to 
apply that clipping to the exported LUTs if enabled. 

Server Setup 

The Enable Server checkbox enables the program to serve up, over a local LAN, the 
current settings of the CDL controls. So far, this has only been used with the Codex 
recorders, but is potentially not limited to them. The Codex recorder incorporated 
in the Arri Alexa XT series of cameras also functions in a similar fashion. When 
requested, the server will return to the requesting device the current 10 CDL values. 
The server currently responds to a request containing “cdl” sent to the local address 
specified (and port number specified here) on your machine’s LAN connection. Note 
that this network server currently uses static IP addresses for both the server, and 
for the requesting devices. To date, it has not been tested with other devices or 
servers (for example – DHCP servers on the LAN. As such it is not recommended to 
operate in either of those fashions. 

As an example, your Macintosh network setting could specify a fixed address of 
192.168.1.10 (with a subnet mask of 255.255.255.0), and your requesting devices 
could have static addresses in that subnet (e.g.-192.168.1.1, and 192.168.1.2, etc.). 



LinkColor by Framewright 

LinkColor v2.3 Operation  12 

The requesting devices should address the port number specified in the Preferences 
dialog. We allow this number to be set anywhere from 6000-65535. Port numbers 
below 12000 are considered to be restricted. However, due to certain equipment 
requirements, we are currently allowing port numbers between 6000 and 12000 to 
be used. Many of these port numbers are dedicated to certain network services, and 
should not really be used for other devices. It is the user’s responsibility to choose a 
non-conflicting port number, especially if other devices (against our 
recommendation) are using the same network, and expect to be addressing the 
same computer. 

It is beyond the scope of this manual to address the proper setup of the requesting 
devices, as they may be varied in type and setup. The necessary setups are likely 
addressed in the appropriate device’s supporting manuals and additional 
documentation. 

For example, the Codex recorders require that the LinkColor Server’s address and 
port number be included in the recorder’s root directory config.xml file: 

config.xml file: 

… 

 <CDLServer> 

  <ServerName>192.168.1.107</ServerName> 

  <ServerPort>50000</ServerPort> 

 </CDLServer> 

… 

Also, a sysconfig (no extension) file needs to be in that root directory, and should 
contain the following entries: 

DigitalVisionCDLEnabled 

AllowRecIfCDLFails 

Additionally, the onboard-filecard.xml, and GUI filecard.xml may need to be 
modified to allow display of the CDL values in those filecards. 

[I’m not sure if they need to be there for the CDL values to get into the metadata, 
but they might, and that’s the way I’ve used it.] 

Much of this is included in the Codex documentation. 

The Alexa XT cameras currently use a fixed port address of 6666, and so the 
LinkColor port needs to be set to 6666 being used. The Alexa XT requires setting the 
CDL Server IP address in camera (your machine’s IP address). The MultiAssign 
window in LinkColor needs to set the camera’s IP address (which can be found in the 
Alexa XT’s System Info window). A reported major bug in prior LinkColor 
implementations using Alexa XT cameras has been resolved in v2.1 
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LUT Size Tab 

 

The LUT Size Tab provides the opportunity to change the cube size that will be 
exported from LinkColor. This will always be converted to a 17^3 cube in the 
HDLinkPro. However, the internal calculations will be at 33^3 and exported LUTs 
will subsequently be in the chosen size. 

File Imports Tab 

 

The File Imports tab gives you a list of the currently supported file types that can be 
Load…-ed into the DeLog LUT or Display LUT. Most of the file formats contain self 
explanatory metadata, and LinkColor will re-size and re-calculate imported files as 
necessary. However, there is no guarantee that all flavors of all of these files will be 
compatible, and should be tested before any assumptions about their suitability is 
made. 
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File Exports Tab 

 

The File Exports tab allows the user to select which files types will be exported when 
the File menu Export… selection is made. Also, you can select which additional LUTs 
you would like to have included in the exported LUTs, as well as several other 
processing options. For example, if you are using a Display LUT which is specific to 
your current monitoring situation, you would probably not wish to include that as a 
rule. In the case of DeLog LUTs, your choice would likely be dependent on the chosen 
workflow for your application.  Other options are likewise dependent upon specific 
situations. 

3D Tab 

 

The 3D tab would allow the user to adjust these settings on a 3D HDLinkPro if these 
settings were supported. Currently, they are dimmed out and not implemented. 



LinkColor by Framewright 

LinkColor v2.3 Operation  15 

Panel Tab 

 
 

The Panel tab allows the user to adjust the responsiveness of the control interface 
supported by the Tangent WAVE panel. When a WAVE panel is connected, it is 
automatically recognized by LinkColor, and its controls will function in parallel with 
those controls on the screen. At this time, no other hardware panel interfaces are 
supported. 

Included in the delivered documentation is a diagram detailing the controller 
assignments on the Tangent WAVE panel. 
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Global Presets Window 

 

The fifty STORE and RECALL fields can store and recall working settings as you 
proceed. You can also make notes (only 49 characters will be stored) in the 
appropriate fields to remind you of the setting contents. These presets also store 
the contents of the associated User Matrix settings, which will be recalled along 
with the other parameters. 

At the top right of the window is a Clear All button that serves to clear the 
contents of all stored Presets in this window, including the Notes fields. 
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User Matrix Window 

 

In this window, the user can make adjustments to the indicated matrix settings. As 
shown, the sliders can all be reset to the nominal state, which is a unity matrix 
setting. These controls can also be individually reset. In the Main window, the effect 
of the User Matrix settings can be bypassed as desired. 

Also, there are 10 positions that serve to store and recall User Matrix settings only. 
Though they store and recall only these User Matrix settings, these settings are also 
stored and recalled in the Global Presets noted in the prior section. As in the Global 
Presets screen, notes (up to 49 characters will be stored) can be entered in the 
appropriate fields to remind you of the setting contents. 

At the mid right side of the window is a Clear All button that serves to clear the 
contents of all stored Presets in this window, including the Notes fields. 
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Saving, Exporting, and Importing 

1. When you quit LinkColor, two files get saved - a .pref preference file and a .lcp 
global and local settings file, both saved in the local user’s preferences 
directory. The .lcp file holds the current settings (as seen in the Main window), 
including checkboxes and including the fifty stored settings, as well as the User 
Matrix presets and current settings. Next time LinkColor is launched, it restores 
the settings from last use as per this file. It also attempts to preserve the 
DeLog or Display LUTs. If they are not found at their indicated paths, the user 
will be so notified. However, the other associated settings will be loaded, and 
the user can find and re-import the desired LUTs and re-save as needed. The 
.pref file contains the preferences as set in the Preferences dialog. 

2. The Save and Save As… items function to save the state of the box, and 
restore that state, as noted in item 1 above. The files saved using these Saves 
are proprietary to the application, and are not LUTs or anything like that, but 
they do restore your settings (including all 50 Global Presets), as well as the 
current state of the Preferences. This file will be saved with an extension of 
.lcr 

3. Opening a saved file (of type .lcr) will restore all of the items in a similar 
fashion as the .lcp and .pref files that are saved at quit and loaded at launch 
by default. 

4. There is currently an Export function in the File menu. It exports files as 
defined in the Preferences dialog. At the time of Export…, the user is given 
the opportunity to select the pages to be included in the export, and to name 
the folder which will contain the selected exports. The settings that are 
currently in effect for the selected page(s) are reflected in the exports. The 
Export-ed name will be used as a prefix for all of the specified exports. The 
page identifier (from the Multi HDLink Assignment page), and an added three 
letter identifier, and appropriate extension will also be appended. 
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The number and types of file exports will periodically be updated, and will be 
reflected in the manual and Preferences dialog. Currently, the available 
options for Export-ing are:  

Blackmagic-Design _hdl.cube 

Truelight™ v2.0 compatible _tru.cube file 

Iridas™ v2.0 _iri.cube file 

Pandora™ _pan.mga (originally developed by Pandora) file. This file is compatible 
with Apple’s Color application as a Display LUT. 

A .cdl XML file. The user should be aware that the .cdl file carries only the Gain, 
Gamma, Ped, and Sat (with adjustments incorporated as per the Warm/Cool and 
Green Shift). These are the parameters supported as Slope, Power, Offset and 
Sat in the specification. Any adjustments of the User Matrix, or inclusion of 
DeLog and/or Display LUTs in the export will, due to this limitation, not be 
reflected in the .cdl export. 

A .lcs file. This is a proprietary file that contains the settings in effect at the time of 
export. In other words, exporting or importing a .lcs file functions in a similar 
fashion to the saving and restoring of individual presets in the Global Settings 
window. 

5. There is an Import function in the File menu that imports .lcs files (described 
above) as well as .cdl files. The .lcs files are each functionally equivalent to a 
single stored preset as saved in the Global Presets window. 

The .cdl Import will import a single event .cdl (similar to those exported by 
LinkColor). Again, these .cdl files contain only the parameters set by the 9 
color sliders and the saturation slider (no DeLog or Display LUTs or Matrix 
settings are included in the .cdl). 

NOTE: Importing a .cdl will force the Ped in Lift Mode checkbox off. That is 
intentional as it is the only way to accurately recover the proper .cdl values. 
The effect of a .cdl import accurately reflects the .cdl values being presented. 
However, it is necessary to adjust the values of the sliders and to deactivate 
the Ped in Lift Mode checkbox. 

The Import selection is limited to .lcs and .cdl files only. 

System Configuration 

All Versions 

The user key for LinkColor is kept at the following path: 

 /Users/Shared/LinkColor/LinkColor.key 
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It enables LinkColor for any users on the licensed serial numbered computer. 

v2.0 and later 

Beginning with version 1.5.x and going forward all major releases will have their 
own directories for storing their .pref and .lcp files. The generic path will be: 

  /Username/Library/LinkColor/version[xx] 

where the xx will be the first two numbers of the release. For version 1.5.2 the 
final directory path would be version15. All subsequent version 1.5.x releases will 
use this directory for their files. If a version 1.6.x is released, the final path would 
be version16. The reason for this strategy is to be able to use any prior release 
with an appropriate set of files for that release. 

Any prior files that you may have saved will likely not load or open with this new 
v2.0 release. However, you can continue to use those files with the appropriate 
prior version of LinkColor, as they are completely independent of one another in 
their operation. 

Version 2.0 is unable to open and use files that were created with earlier versions 
even though new directories will be created for its preference storage. An internal 
header will track the compatibility of the files that can be used and if the files are 
not compatible an error message will be displayed. 

Of course, exported .cdl files and exported 3D LUTs created with earlier versions 
would be compatible as either Import…-ed or Load…-ed files.  
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Order of Operations 

The order of LinkColor adjustment operations is as follows (if enabled): 

 

1. Legal to Extended conversion, 

2. ToneMap application, 

3. User Matrix, 

4. *DeLogLUT  *(if “Precedes Sliders” is checked), 

5. CDL Sliders, Ped, Gamma, Gain (SOP), then Saturation, 

6. **DeLogLUT **(if “Precedes Sliders” is unchecked), 

7. Display LUT, 

8. Extended to Legal Conversion. 

 

The output clipping is applied at multiple stages internally. 


